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Abstract

Dolphin is the default file manager for KDE, designed with usability as a pri-
mary focus.
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Chapter 1

Introduction

Dolphin is KDE'’s default file manager. It aims to improve usability at the user
interface level. Dolphin focuses only on being a file manager whereas Kon-
queror, which was KDE'’s default file manager in KDE 3 and can still be used
for file management, is a universal viewer for many file types.

This development approach allows for concentrating on optimizing the user
interface for the specific task of file management.

Please report any problems or feature requests to the Dolphin author via the
bug report dialog. This is accessible from the Help — Report Bug... menu of
the application.
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2

Using Dolphin

2.1 Dolphin User Interface

The screenshow below shows Dolphin’s default user interface:
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Dolphin’s default user interface.

The elements of the default user interface are:

e The menu bar, which provides access to all commands and configuration
options. See the Command Reference for a list of all menu commands.
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e The toolbar, which can be used for quick access to frequently used actions.
The toolbar can be customized by clicking it with the right mouse button
and choosing Configure Toolbars... from the context menu or via Settings
— Configure Toolbars... from the main menu.

e The location bar, which always displays the path to the current folder. It can
be switched between two different modes, see the section on the location bar
for details.

e The view, which shows all files and folders in the current folder.

e The Places panel, which provides quick access to bookmarked locations and
disks or other media.

e The Information panel, which shows a preview of the current folder or the
file which is currently hovered with the mouse and can be used for rating
the file and adding tags or comments to it.

e The status bar. It displays the name, size and type of the file which is cur-
rently hovered with the mouse, or the number and size of the files which are
selected. At the right, there is a zoom slider that permits to adjust the size of
the icons in the view.

2.2 The Dolphin View

2.2.1 Using the View

The view displays all files and folders in the current folder. These items can be
accessed or manipulated in different ways:

e A file or folder can be opened by clicking it with the left mouse button (or
double-clicking, if Double-click to open files and folders is enabled in the
Navigation section of the settings).

e Clicking any item or the white area around the items with the right mouse
button opens a context menu which provides access to many frequently used
actions for the item or the current folder, respectively.

o If the left mouse button is pressed on an item, but not immediately released,
the item can be dragged and dropped in another folder in the current view
or in another Dolphin view (in another Dolphin window or in the same win-
dow if the view is split, see below) to move or copy it or to create a symbolic
link. Items can even be dropped in another application to open them in this
application.

Dolphin remembers the history of visited folders. To navigate backward or
forward in the history, the corresponding buttons in the toolbar can be used:
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@ Back 59 Forward

The Back and Forward buttons in the toolbar can be used to navigate in the
history.

2.2.2 Dolphin View Appearance

The toolbar contains buttons to control the appearance of the view:

“adl leons | == Details Colurnns m Preview 4 Splt

The buttons in the toolbar which control the appearance of the view.

All the settings discussed below and other options concerning, e.g., the sorting

of the files in the current folder can also be modified in the View menu and in
the View Properties dialog. By default, these settings are remembered for each

folder separately. This behavior can be changed in the General section of the
settings.

2.2.2.1 View Modes

The first three buttons in the above screenshot switch between Dolphin’s view
modes.

e In the Icons view, which is the default, files will be represented by an icon
that visualizes the file type, and a folder icon will be shown for subfolders.

o In the Details view, the folder contents are displayed as a detailed list which
contains the name, size and last modification time of each item. Additional
columns can be added by clicking a column header with the right mouse

button.
The details view offers the option Expandable Folders, which can be enabled
in the View Modes section of the settings. This option permits to view the
current directory in a tree-like fashion: Each subfolder of the current folder
can be ‘expanded’ by clicking on the + button next to it.

e In the Columns view, multiple levels of the folder structure can be viewed
at once. If a subfolder is clicked, a new pane showing the contents of that
folder is opened at the right edge of the view.

2.2.2.2 Preview

If Preview is enabled, the icons are based on the actual file or folder contents.
E.g., for images a scaled down preview of the image is shown.
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2223 Split

If Split is clicked, two views are shown which can display the contents of dif-
ferent folders. This can be convenient for moving or copying files.

2.2.3 Selecting Items in the View

There are several ways to select items in the view. Once a group of items is
selected, all actions, such as Cut, Copy, Move to Trash, and drag and drop
operations, affect all selected items.

2.2.3.1 Selecting Items Using the Mouse

You can press the left mouse button somewhere in the view and draw a rect-
angle around a group of items before releasing the button. This will select
all items in the rectangle and clear the previous selection. If the Shift key is
pressed during the selection process, the previous selection is kept.

If the Ctrl key is pressed while an item is clicked with the left mouse button,
the selection state of this item is toggled. If the Ctrl key is pressed while a
rectangle is drawn around a group of items as described above, the selection
state of all items in the rectangle will be toggled.

If the Shift key is pressed while an item is clicked with the left mouse but-
ton, all items between the previous current item and the clicked item will be
selected.

If Show selection marker is enabled in the Behavior tab of the General section
of the settings, a small + or - button appears in the top left corner of the item

which is currently hovered with the mouse. Clicking this sign selects or
deselects the item, respectively.

2.2.3.2 Selecting Items Using the Keyboard

If an arrow key, Page Up, Page Down, Home, or End is pressed, the new
current item is selected, and the previous selection is cleared.

If the Ctrl key is held while one of the above keys is pressed, the selection
remains unchanged.

If the Shift key is held while one of the above keys is pressed, all items
between the previous current item and the new current item will be selected.

If Ctrl+Space is pressed, the selection state of the current item is toggled.

Shift+A selects all items in the view.

Ctrl+Shift+A toggles the selection state of all items in the view.
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2.3 Location Bar

The location bar, which can be found on top of Dolphin’s view, displays the
path to the current folder. The location bar has two modes.

2.3.1 Bread Crumb Mode

In the ‘bread crumb’ mode, which is the default, each folder name in the path to
the current folder is a button which can be clicked to quickly open that folder.
Moreover, clicking the >” sign to the right of a folder opens a menu which
permits to quickly open a subfolder of that folder.

The icon in front of the path can be clicked in both modes to open a menu
which offers quick access to ‘places” and storage media. You can add and edit
places, see the section about the Places Panel for details.

'='> Home » Files * Pictures

Location bar in bread crumb mode.

2.3.2 Editable Mode

When in bread crumb mode, clicking in the grey area to the right of the path
with the left mouse button switches the location bar to the ‘editable” mode,
in which the path can be edited using the keyboard. To switch back to bread
crumb mode, click the check mark at the right of the location bar with the left
mouse button.

By [EI fhome/fuser/Files/Picturas/ %] v] W

Location bar in editable mode.

2.4 Panels

Dolphin allows a number of panels to be placed next to the view. These can
be enabled in View — Panels. By clicking and dragging a panel title, the panel
can be moved to a different position.

2.4.1 Places

The Places panel is located at the left of the window by default. The Places
panel shows any locations you have bookmarked. It also shows any disk or
media attached to the computer.

The easiest way to add a folder to the Places panel is to drag it and drop it
in the panel. Moreover, you can click inside the panel with the right mouse
button and choose Add Entry... from the context menu.
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2.4.2 Information

The Information panel shows extended information about the selected items(s),
including size, type, and date of last modification. It also features a large pre-
view of the selected item and permits to assign a rating, tags, and comments to
it.

2.4.3 Folders

The Folders panel shows a tree view structure of the file system. It only shows

folders. Clicking a folder with the left mouse button opens this folder in the
Dolphin view.

2.4.4 Terminal

This panel contains a terminal. The terminal will open at the folder currently
shown in the Dolphin view. Changing the folder in the active Dolphin view
will update the working folder of the terminal. The terminal only works with
local media. Note: Changing folder in the terminal will not affect the Dolphin
view.

2.5 Quick Tips

The following are a number of tips to save time when using Dolphin.

2,51 Quick Bookmarking

To quickly create a bookmark in the Places panel for the current folder, right
click in the work space and click Add to Places in the context menu.

2.5.2 Finding Files

Dolphin is capable of searching for files. If Ctrl+F is pressed or using Tools —
Find File..., KFind will open already set up to search within the current folder
and any sub-folders.

2.5.3 Mounting Storage Media

A quick way to mount Storage Media is to click on the device in the Places
panel. This will mount and open the device in Dolphin.
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2,54 Undo Actions

Dolphin is capable of undoing changes you have made to files. For example
if you moved a file to the Trash, Dolphin can undo this and move it back to
its original location. To undo an action, press Ctrl+Z or select Edit — Undo:
(action name) in the menu, e.g. Undo: Rename.

2.5.5 Renaming A Batch Of Files

Dolphin is capable of renaming a number of files at the same time. Each file will
have the file name specified, including a number, e.g., Imagel jpg, Image2.jpg,
Image3.jpg. This can be useful, e.g., for pictures taken with a digital camera.

If you wish to rename a batch of files, first select the files to be renamed. This
can be done by pressing the left mouse button and drawing a rectangle around
the files to be renamed before releasing it, or by holding Ctrl and clicking each
file to be renamed (see Selecting Items in the View for more details on item
selection). Then open the batch-rename dialog by pressing F2 or via the File
menu: File — Rename....

Then enter the name you wish to give the files. The # character must be present
within the name. The files will then be renamed, where the # character is re-
placed by a different number for each file.

2.5.6 Comparing A Selection Of Files

If the Kompare application is installed, you can use it to see the differences
between two files.

First select the two files to be compared. Then launch the Kompare application
via the Tools menu: Tools — Compare Files. Kompare will then open showing
the differences between the files.

2.5.7 Filtering Files

Dolphin is capable of filtering files, i.e., showing only those items in the view
whose name contains a given text. For example, if you wish to show only the
MP3 files within a folder, you could filter for “.mp3’. This would then filter out
all files whose name does not contain “.mp3’.

To filter files, first enable the filter bar, either by pressing Ctrl+I or via the menu:

Tools — Show Filter Bar. You can then enter the text to be filtered in the filter
bar. The filter bar can be disabled either by pressing Esc, or using the menu:

Tools — Show Filter Bar.



The Dolphin Handbook

Chapter 3
Configuring Dolphin

Dolphin distinguishes two different kinds of settings:

e Settings which affect the general behavior of Dolphin. These can be config-
ured using the Preferences Dialog.

e Settings which determine how the contents of a folder are displayed in Dol-
phin. These settings are called View Properties and can be controlled with
toolbar buttons, via the View menu, and with the View Properties Dialog.
In the default configuration, the view properties are remembered for each
folder, but Dolphin can also be configured to use common view properties
for all folders in the General section of the settings.

3.1 The Dolphin Preferences Dialog

The Preferences Dialog is opened via Settings — Configure Dolphin... in the
menu in Dolphin’s main window. The settings are divided into several groups
which can be accessed by clicking the corresponding icon on the left of the
dialog.

3.1.1 Startup

This group contains settings which control the appearance of Dolphin on startup.
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= Dolphin Preferences - Dolphin o & & X
Startup
Home Folder
-]
-]
View Modes Location: [file:/fhome/user] al =5
4
Use Current Location Use Default Location
Mavigation
PZ | Split view mode
Services | Editable location bar
“» | Show full path inside location bar
T:;;h | Show filter bar
v
General
7 Defaults W 0K ¥ Apply @ Cancel

Startup Settings in Dolphin’s Preferences Dialog.

The Home Folder is the folder which is opened on startup. The location of
the folder can be entered directly or chosen in a dialog which can be opened
by clicking the button showing a ‘folder” icon. Moreover, the current location
or the default location (which is the user’s home folder) can be used as the
Home Folder by clicking the corresponding button.

Split View Mode controls if the Dolphin view is split on startup or not.

Editable location bar controls if the location bar is in editable mode on startup.

The bread crumb mode of the location bar is used otherwise. See the section
about the location bar for details about the two modes.

If Show full path inside location bar is enabled, the full path of the current
location is shown in the bread crumb mode of the location bar. Otherwise,
a shortened version of the path is shown if it begins with the path of one of
the places in the Places panel.

Show filter bar controls if the filter bar is shown on startup or not. See the
section on the filter bar for details.

10
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3.1.2 View Modes

This group contains settings which control the behavior of Dolphin’s view
modes. The three view modes (Icons, Details, and Columns) are accessible
via the tab bar on top.

= (&8 Dolphin Preferences - Dolphin & @ &) s
1/\5} View Modes u
E B e
Startu
P = lcons | o | Details Column
E lcon Size
View Modes
Default:
.' 1 1 T 1 1 1 1 1 1 1 1 1 1 1 1 1 1
= Preview: ’
Navlgatlnn 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
F Text
Services Font: System Fonts | | Choose...
L ]
! Mumber of lines: 2 O
-
Trash Text width:  Medium w
AT Grid
General
Arrangement: Rows v
Grid spacing: small v
@& Defaults & 0K || & Apply || @ Cancel |

View Modes Settings in Dolphin’s Preferences Dialog.

3.1.21 Common settings for all view modes
All three view modes have some common settings:

e Sliders which control the size of the icons. The Default or Preview sizes
are used if previews are disabled or enabled, respectively. Note that the

icon size can be changed easily with the zoom slider in the status bar if the
corresponding option is enabled in the General section of the settings.

e A setting for the font used in the view mode: either the system font or a
custom font can be chosen.

The settings which apply to only one of the view modes are discussed below.

11
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3.1.2.2 Icons

Besides the common settings of all view modes, the icons view has the follow-
ing settings:
e In the Text section:

— Number of lines is the number of lines of text which appear next to the
icons. If the name of a file or folder is too long to fit into the chosen number
of lines, it will be abbreviated, and “...” will be added at the end.

- ;Fefxt Width controls the maximum width that is reserved for the text of a
ile item.

e In the Grid section:

- If Arrangement is set to Rows or Columns, the items will be arranged in
rows from left to right or in columns from top to bottom, respectively.

- Grid spacing controls how far the items are apart in the view.

3.1.2.3 Details

Besides the common settings of all view modes, the details view has only one
setting:

¢ If Expandable Folders is enabled, the details view can show the contents of

all subfolders of the current folder as a tree. A branch of the tree can be
expanded or collapsed by clicking the + or - button next to each subfolder.

3.1.2.4 Columns

Besides the common settings of all view modes, the columns view has only one
setting:

e The Text Width setting controls the width of each column in the view.
3.1.3 Navigation

This group contains settings which control how navigation in the folder struc-
ture and in archives works.

12
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= Dolphin Preferences - Dolphin & & @ X
Pt Mavigation ']
e o
Startup
Mouse
-]
@ *  Single-click to open files and folders

Vi Mod
tew Modes Double-click to open files and folders

| Open archives as folder

Mavigation

Pz

Services

| Open folders during drag operations

L =]
"“-l_j-"
Trash
v

General

7 Defaults W 0K ¥ Apply @ Cancel

Navigation Settings in Dolphin’s Preferences Dialog.

e Dolphin can be configured to open items with a single mouse click (Single-
click to open files and folders) or a double mouse click (Double-click to open
files and folders). In the latter case, a single mouse click will select the file or
folder.

e Archives will be opened inside Dolphin, and not in an external application,
if Open Archives as folder is enabled.

e If Open folders during drag operations is enabled, dragging an item with the
mouse and hovering a folder with it for a short time will open that folder.
This permits to move or copy items quickly to folders which are several lev-
els deeper in the folder hierarchy.

3.1.4 Services
This group offers a selection of services that can be shown in the Actions sub-

menu of Dolphin’s context menu which appears when clicking a file or folder
with the right mouse button.

13
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3.1.5 Trash

This group contains settings which control the behavior of the trash.

= Dolphin Preferences - Dolphin & @ & X
A Trash e
Bjge di
Startup , =
| Delete files older than: 4
= +' Limit to maximum size
View Modes . )
Maximum size: 10,000 % $ (9.84 GByte)
1
When limit reached: Warn Me v
Mavigation
Services
5/ Defaults | & 0K || « Apply || @ Cancel

Trash Settings in Dolphin’s Preferences Dialog.
e Files which are older than a configurable number of days can be deleted
automatically.

e The size of the trash can be limited to a configurable percentage of the disk
size. If this limit is reached, a warning can be issued, or the oldest or largest
files can be deleted automatically.

3.1.6 General

This group contains settings which control the general behavior of Dolphin.
The group is divided further into four subgroups which can be accessed using
the tab bar on top.

14
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B - Dolphin Preferences - Dolphin o & & X
General
@ o
Startu )
P Behavior | Prewviews Context Menu  Status Bar
-]
= View Properties
View Modes
®  Remember view properties for each folder
1
Y _ Use common view properties for all folders
Mavigation
| Ask For Confirmation When
- Moving files or folders to trash
Services -
- +/| Deleting files or folders
4 +| Closing windows with multiple tabs
Trash
@ | Rename inline
Show tooltips
General —
+/| Show selection marker
+/| Natural sorting of items
7 Defaults W 0K ¥ Apply @ Cancel
General Settings in Dolphin’s Preferences Dialog.
3.1.6.1 Behavior Tab

In the View Properties section, it can be configured if the view properties are
stored for each folder or if common view properties are to be used for all
folders.

In the Ask for Confirmation When section, warning dialogs which are shown
before potentially harmful actions can be enabled.

If Rename Inline is enabled, no dialog asking for a new file name will be
opened when renaming a file or folder. Instead, the name can be edited
directly inside the view.

When hovering a file or folder with the mouse, a small window with infor-
mation about it is shown next to it if Show tooltips is enabled.

Show selection marker shows a small + or - button above an item’s icon if
tﬂe item is hovered with the mouse. These can be used to select or deselect
the item.

15
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e Natural sorting of items controls how items are sorted in the view. If this
option is enabled, the sort order of three example files will be

1. Filel,
2. File2,
3. Filel0.

If this option is disabled, the normal alphabetical sorting will be used, which
leads to the sort order

1. Filel,
2. Filelo,
3. File2.

3.1.6.2 Previews Tab

In this tab, it can be configured for which file types previews are shown. More-
over, the maximum filesize for which previews are generated can be chosen,
and it can be configured if thumbnails embedded in files are used or not.

If previews are enabled for folders, previews of some files in the folder will be
shown inside a folder’s icon.

3.1.6.3 Context Menu Tab

In this tab, it can be chosen if the Delete, Copy To, and Move To commands are
shown in the context menu which appears when right-clicking a file or folder.
3.1.6.4 Status Bar Tab

In this tab, some additional items can be enabled for the status bar, provided
the status bar is wide enough:

e A zoom slider which can be used to change the icon size quickly.

e A bar that shows how much space is free on the current drive.

3.2 Folder View Properties

The following settings control how the contents of a folder are displayed in the
Dolphin view, and are stored on a per-folder basis by default:

e The view mode (Icons, Details, Columns)

e The sorting of items, which is determined by the sort order (ascending, de-
scending) and the attribute (such as name, size,...) that the items are sorted

by

16
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Sorting of folders and files — are folders shown first or not?

Previews — are they shown instead of icons (based on the settings made in
Previews tab of Dolphin’s General settings) or not?

Are items shown in groups in the Icons view?

Are hidden files shown?

What additional information (besides the name) is shown in the Icons or
Details view?

The view properties can be configured in the View menu, some (such as the
view mode) can also be changed using toolbar buttons.

17
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3.2.1 The View Properties Dialog

= View Properties - Dolphin W & &
Properties
View mode: ::-|lcons v
Sorting: Ascending w By Name W

+ | Show folders first
Show preview
Show in groups
Show hidden files

Additional Information

Apply View Properties To

®  Current folder
Current folder including all sub folders

All folders

Use as default for new folders

| w oK || « apph @ cancel

The View Properties Dialog.

The View Properties dialog can be used to quickly modify several view proper-
ties at once. This is done for the current folder, for the current folder including
all subfolders, or even for all folders, depending on the choice made in the

Apply View Properties To section.

If Use as default for new folders is enabled, the chosen view properties will
also be used for all folders which do not have customized view properties yet.

18
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Chapter 4

Command Reference

4.1 The Menubar in Dolphin’s Main Window

41.1 The File Menu

File — Create New Creates a new object (such as a folder or a text file) in the
current folder.

File — New Window (Ctrl+N) Opens a new Dolphin window.
File — New Tab (Ctrl+T) Opens a new tab.
File — Close Tab (Ctrl+W) Closes the current tab.

File — Rename (F2) Renames the currently selected item(s).
File — Move to Trash (Del) Moves the currently selected item(s) to the trash.

File — Delete (Shift+Del) Permanently deletes the currently selected item(s).
The items are not moved to the trash and cannot be restored.

File — Properties (Alt+Return) Shows the properties dialog for the currently
selected item(s).

File — Quit (Ctrl+Q) Exits Dolphin.

4.1.2 The Edit Menu

Edit — Undo (Ctrl+Z) Undoes the last action performed by Dolphin.
Edit — Cut (Ctrl+X) Cuts the currently selected item(s).

Edit — Copy (Ctrl+C) Copies the currently selected item(s).

19



The Dolphin Handbook

Edit — Paste (Ctrl+V) Pastes the currently copied/cut items to the current folder.
If the clipboard does not contain files or folders, the clipboard contents
(such as text or image data) will be pasted into a new file.

Edit — Select All (Ctrl+A) Selects all files and folders in the current folder.

Edit — Invert Selection (Ctrl+Shift+A) Selects all unselected items and dese-
lects all selected items in the current folder.

4.1.3 The View Menu

View — Zoom In (Ctrl++) Increases the size of icons in the view.
View — Zoom Out (Ctrl+-) Decreases the size of icons in the view.

View — View Mode Changes the view mode to Icons (Ctrl+1), Details (Ctrl+2)
or Columns (Ctrl+3).

View — Sort By Changes whether items are sorted by Name, Size, Date, Per-
missions, Owner, Group or Type. Descending reverses the sort order.
Folders First sorts folders before files.

View — Additional Information Displays additional information like Size, Date,
Permissions, Owner, Group or Type in the different views.

View — Preview Displays a symbolic preview of the file contents in the dif-
ferent view modes.

View — Show in Groups Displays the content of the current folder grouped
by file type (only available in the Icons view mode).

View — Show Hidden Files (Alt+.) Shows all the hidden files and sub-folders
within the current folder.

View — Split (F3) Enables and disables the split view mode.
View — Reload (F5) Reloads the current folder.

View — Stop Stops loading/reading the contents of the current folder.

View — Panels Enables and disables the different panels: Places (F9), Infor-
mation (F11), Folders (F7) and Terminal (F4).

View — Navigation Bar — Editable Location (Ctrl+L) Changes the navigation
bar between the two modes; the bread crumb mode and the editable
mode.

View — Navigation Bar — Replace Location (F6) Switches the navigation bar
to editable mode, if necessary, and selects the location such that it can be
replaced quickly.

View — Adjust View Properties... Opens the View Properties Dialog.
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414 The Go Menu

Go — Up (Alt+Up) Changes to the folder above the current folder.

Go — Back (Alt+Left) Changes to the previously viewed folder.

Go — Forward (Alt+Right) Undoes a ‘Go Back” action.

Go — Home (Alt+Home) Changes to the users home folder, e.g., /home/Peter/.

Go — Recently Closed Tabs Shows a list of recently closed tabs which can be
reopened.

4.1.5 The Tools Menu

Tools — Find File... (Ctrl+F) Opens KFind within the current folder.

Tools — Show Filter Bar (Ctrl+I) Enables and disables the filter bar.
Tools — Open Terminal (Shift+F4) Opens Konsole within the current folder.

Tools — Compare Files Compare the currently selected files with Kompare.

Tools — Select Remote Charset Offers to choose the charset used by a remote
connection manually.

4.1.6 The Settings Menu

Settings — Show Menubar (Ctrl+M) Hides and shows the menubar.

Settings — Show Toolbar Hides and shows the Main Toolbar and the Search
Toolbar.

Settings — Configure Shortcuts... Opens the shortcut configuration dialog.
Settings — Configure Toolbars... Opens the toolbar configuration dialog.

Settings — Configure Dolphin... Opens the Dolphin configuration dialog.

4.1.7 The Help Menu

Help — Dolphin Handbook (F1) Invokes the KDE Help system starting at
the Dolphin help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within Dolphin will open a
help window (if one exists for the particular item) explaining the item'’s
function.
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Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help — About Dolphin This will display version and author information.

Help — About KDE This displays the KDE version and other basic informa-
tion.
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Chapter 5

Miscellaneous Questions

1. Has Dolphin replaced Konqueror?

Dolphin is not intended to be a competitor to Konqueror: Konqueror acts
as universal viewer being able to show HTML pages, text documents,
folders and a lot more, whereas Dolphin focuses on being only a file man-
ager. This approach allows to optimize the user interface for the task of
file management.

2. How can I get involved with the development of Dolphin?

The easiest way to get involved with Dolphin is to drop the developers
an email. If you email Peter Penz (Lead Developer/Project Leader), what
you can do, how much time you can devote etc., he will let you know
what you can do in the project. If you wish to contribute to the documen-
tation you can also email Peter Penz. The email address of Peter Penz
can be found on the main page of the documentation, or in the Credits
section.

3. How can I submit bug reports?
The official channel for submitting bug reports is via the KDE bug track-
ing system. The KDE bug tracker can be found at http://bugs.kde.org.
4. How can I submit feature requests?

The official channel for submitting feature requests is via the KDE bug
tracking system. The KDE bug tracker can be found at http:/ /bugs.kde.org.
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Chapter 6
Credits and License

Dolphin
Program copyright 2005-2009 Peter Penz peter.penz@gmx.at

Contributors:

o Cvetoslav Ludmiloff ludmiloff@gmail.com
e Stefan Monov logixoul@gmail.com
e Michael Austin tuxedup@users.sourceforge.net

e Orville Bennett obennett@hartford.edu

Documentation copyright 2005 Peter Penz peter.penz@gmx.at

Documentation copyright 2006 Orville Bennett obennett@hartford.edu
Documentation copyright 2006 Michael Austin tuxedup@users.sourceforge.net
Documentation copyright 2009 Frank Reininghaus frank78ac@googlemail.com

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.
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Appendix A

How to get Dolphin

Dolphin is part of the kdebase package which an essential part of KDE.
For instructions on acquiring KDE please see http:/ /www.kde.org.

For further information about Dolphin you might want to visit http:/ /dolphin.kde.org
or http:/ /userbase.kde.org/Dolphin.
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